Warfarin Help Documentation
Table Of Contents

Warfarin Management ................................................................. 1
Warfarin Management

The Warfarin Management module is a powerful tool for monitoring INR results and advising on the dosing regime. The Warfarin module can be accessed in two ways, firstly from within a patient record in your Clinical System via a single left click on the Notification Buttons, located towards the top right hand corner of the screen, as shown in the diagram below.

Secondly, the Warfarin module can also accessed without the need to go into each individual patients record in the clinical system. This is done by selecting the patient from Warfarin Monitor, and makes it very quick, easy and straight forward to manage patients in a Warfarin clinic environment.

Before the Warfarin Dose screen can be accessed, each patient must have a new diagnosis recorded through the New Diagnosis option in the Warfarin management module. If the user selects something other than New Diagnosis prior to a new diagnosis indication being made then they will be directed to the New INR Diagnosis screen. If this is the first time you are using Warfarin monitor then it is worth looking at the Warfarin Getting Started guide, which helps to identify the patients who potentially need to be under Warfarin management (i.e. being prescribed Warfarin).

Once the patient has a diagnosis indication then the Warfarin Dose History screen appears and can be used to record Historical INR results and Warfarin Dose values.

Alternatively, if a recall date has been set, a popup appears when the patient record is opened. The popup is displayed as “Warfarin Adjustment” along with the recall date, as shown in the diagram below. Double clicking takes the user directly to Warfarin Dose. The Warfarin monitoring popup appears on the “Others” part of the Notification Button but can be disabled or amalgamated with the QOF button by altering the settings on the Options tab.
1. Log into the Clinical System in the normal way, but do not open any patient records.
2. Right click on the **Light Bulb** program icon in the Notification area of your Windows Taskbar, and select **Warfarin Monitor** from the menu.

   **Note** The Warfarin Monitor list then shown will be empty if you are running **Warfarin Monitor** for the first time, as only the patients with a current Diagnosis Indication are shown.

   The first time you use Warfarin Management it is best to start by setting the Practice Defaults so that they are correct for your practice.

3. On the **Practice** menu, click on **Defaults**, and confirm the **Practice Defaults** are correct.

4. On the **File** menu, click on **Scan patients**.

   The window is then populated with patients who are currently taking Warfarin. The list excludes patients who have a Diagnosis Indication that is current (i.e. those patients who appear on the Warfarin Monitor list e.g. in the previous window).

5. Double Click on the patient you wish to **Monitor**.

   If the patient does not have any Diagnosis Indication then you will be taken to **New INR/Warfarin Diagnosis** where you can enter one, and then onto the **Warfarin Dose History** screen. If the patient does have an Indication but not a current one then you will be taken straight to the **Current INR/Warfarin Diagnosis screen** (This will not be the case if you have not used BlueBay Warfarin Monitor before).

6. The patient will from this point on appear in the Warfarin Monitor list, which would have previously been empty.

7. A double click on a Patient in the Warfarin Monitor list will open up the Warfarin Dose screen where subsequent INR values can be recorded and a new Warfarin Dose regime calculated.
INR / Warfarin Diagnosis Screen

The INR / Warfarin Diagnosis Screen is the same for a New and Current Diagnosis. They differ slightly in the way that they are used. Any previous diagnosis Readcodes recorded on the patient's record are displayed in the History column on the line which correlates to the relevant indication. Select from the following:

New INR / Warfarin Diagnosis

To add a New Diagnosis Readcode, do the following:

1. Left click on the expand button ( ) to view the details of each indication.
2. Double click on the line of the relevant indication or click on the Codeset Button ( ).
3. Readcodes can be entered by placing a tick in the Apply column alongside the Readcode and clicking on the OK button. The relevant indication is then placed in the Indication area which is towards the bottom of the screen. For further information see Recording Information Using the Readcode Data Entry Screen.
4. The Start Date will by default show today's date but can be backdated if necessary by clicking in the down arrow and selecting it from the calendar.
5. Where the treatment period is known, an end date can be entered onto the End Date box also by clicking in the down arrow and selecting it from the calendar.
6. Click OK.
Note: Previous diagnostic read codes can be used as indications by selecting the down arrow to display the History and double clicking on the relevant one.

Current INR / Warfarin Diagnosis

The Current Diagnosis screen is extremely similar to that of the New Diagnosis screen. During a treatment period the New Diagnosis option on the menu will be unavailable, instead the Current Diagnosis option will be displayed. This screen also shows the most recent diagnosis where the treatment period has ended. It may be necessary to extend the treatment period by altering the End Date.

Note: If the End Date entered has passed, End Date will appear in Red text to notify that the treatment period is complete and any additional dosing data entered today will not fall into the current dosing period. When the end date does appear in red (e.g. the treatment period has ended) then a New Diagnosis option will be available on the Warfarin menu.
Using the Warfarin Dose Screen

The Warfarin Dose screen can only be accessed when a New Diagnosis has been entered through Warfarin Monitor. The Warfarin Dose screen makes it very easy to monitor and calculate INR and Warfarin dosing respectively.

It is important that you enter the last five historical INR results and Warfarin doses (if they exist) to ensure that the new Warfarin dose is calculated correctly. If these have been previously recorded in the patients notes then they should appear on the History and Trend Tabs. If not, they may need to be entered via the Warfarin Dose History screen.

The INR & Dose Tab is split into two sections. The top half of the screen displays information about the Current INR and Dose and the bottom half of the screen allows the user to enter a new INR value and suggests the New Dosing regime.

To record a New INR value and allow BlueBayCT Warfarin Management to recommend a dosing regime, do the following:-

1. Use the arrows or type directly into the INR box the new INR value.
2. The Advised Warfarin Adjustment is shown below. If correct click on the Use button to allow the regime to be calculated.

Tip  To save time, if the relevant INR value has already been entered into the clinical system (e.g. by a nurse or automatically from the lab), then there is no need to re-enter it.
in the INR box, and the Use button will be available in this case. This misses out the step of having to enter the INR value into the INR box.

**Note**: If the dose cannot be achieved with the tablet strengths available then the option to round the weekly dose **Up** or **Down** will become available and must be selected before clicking on **Use**.

3. The weekly dosing regime will then be shown, and can be printed out and given/posted to the patient by clicking on **Print Report**.
4. The recommended Recall date will also be shown.

**Caution**: If the recall date appears in red it means the patient is due to be recalled on a day when the Warfarin clinic is not run so the clinician can take the necessary steps to either bring the recall date forward or delay it to a suitable Warfarin clinic day. Warfarin clinic days can be defined in **Practice defaults**.

5. Additional information can be recorded on the **Treatment and Advice** Tab if necessary.
6. If necessary all the INR and Warfarin Dose data can be viewed on the **History** and **Trends** Tab.
7. Click **OK** to save the changes in **Warfarin Dose**.

**Note**: If **Warfarin Dose** is being accessed through the patients individual record in the clinical system, rather than through **Warfarin Monitor**, then the encounter should also be saved as normal from within the clinical system.
INR Practice Defaults

**Warfarin Management**

**INR Practice Defaults**

This area of the Practice defaults screen contains configuration parameters that will affect how the software calculates the Warfarin adjustment. The Warfarin adjustment algorithm that is used during the calculation can be either set to Hillingdon or Coventry/Warwickshire method.

**Note**  The Practice Defaults screen allows you to configure a number of settings for any new patients who are monitored by the Warfarin management software. Any changes made to these settings will not affect the existing patients but will apply to any new patients who are monitored.

**INR (Maintenance Period)**

The INR Target range is a range which if the INR value falls inside it, then no change to the dose will be made. This INR Target range has a default value of 2 to 3 but can be altered if necessary. The INR adjustment range is the range which the adjustment algorithm will hold true and recommend a dose. If the INR value falls outside of this range then a dosing regime will not be calculated. If the Hillingdon Warfarin adjustment algorithm is selected above then the Hillingdon coefficient can be changed from the default value. If the Coventry / Warwickshire adjustment algorithm is used then this option will be greyed out.
Warfarin Help Documentation

**Note**  The Practice Defaults screen allows you to configure a number of settings for any new patients who are monitored by the Warfarin management software. Any changes made to these settings will not affect the existing patients but will apply to any new patients who are monitored.

**Tablet Strength**

The tablet strengths that are available to the patient can be selected under the Tablet strength area so consideration can be taken so that the daily dosing value can be achieved from the tablet combinations available. Where the weekly dosing regime is not possible the user will have a choice to round up or down when choosing the dosing regime. The 1mg tablet strength cannot be made unavailable to the practice as this is a most unlikely scenario.

**Note**  The Practice Defaults screen allows you to configure a number of settings for any new patients who are monitored by the Warfarin management software. Any changes made to these settings will not affect the existing patients but will apply to any new patients who are monitored.

**Clinic Days**

The Clinic Days are used to record the days of the week that the practice holds Warfarin clinics, and can be chosen by checking the relevant box. This is relevant to the recall date given to the patient during the calculating of the dosing regime. If the recall date is on a day that the Warfarin clinic does run on, then the Recall Date appears in Red. This alerts the clinician that the patient is due to be recalled on a day when the Warfarin clinic is not run so the clinician can take the necessary steps to either bring the recall date forward or delay it to a suitable Warfarin clinic day.

**Recalls Tab**

The Recalls tab on the Practice Defaults screen contains the recall periods used by the Induction and Maintenance periods. This tab is for illustrative purposes only and cannot be changed by the user.

**References Tab**

The References tab on the Practice Defaults screen contains the list of references cited during the development of this module. During the development and testing of this module the papers listed here were referenced and the methodologies used were taken into consideration when developing the software.
Warfarin Monitor

Warfarin Monitor is accessed as shown in Warfarin Getting Started guide. By selecting a patient with a left click and selecting an option from the **Patient** drop down menu, a number of tasks can be performed. The same options can be accessed by right clicking on the relevant patient.

<table>
<thead>
<tr>
<th>Patient Name Column</th>
<th>The patient name and date of birth is displayed here.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sex Column</td>
<td>The sex of the patient is displayed here.</td>
</tr>
<tr>
<td>Active Column</td>
<td>If the patient has a current Indication then the patient is <strong>Active</strong> and a tick is shown.</td>
</tr>
<tr>
<td>Abnormal Column</td>
<td>When the INR value falls inside the Target Range the INR result is said to be <strong>Normal</strong>. Likewise if the INR result is outside of the Target Range then it is said to <strong>Abnormal</strong> and red flag ( 🟠 ) is displayed.</td>
</tr>
<tr>
<td>Recall Column</td>
<td>The <strong>Recall</strong> column displays the date the patient is to be recalled to have a new INR reading.</td>
</tr>
<tr>
<td>Due Column</td>
<td>A tick appears in the <strong>Due</strong> column if the Recall date is due or has passed. Those patients who are due also appear in <strong>Black</strong> as opposed to those who are not due appearing in <strong>green</strong>.</td>
</tr>
<tr>
<td>INR Column</td>
<td>The <strong>INR</strong> column displays the patients most recent INR result.</td>
</tr>
<tr>
<td>Warfarin Column</td>
<td>The <strong>Warfarin</strong> column displays the patients most recent Weekly Warfarin dose.</td>
</tr>
<tr>
<td>Diagnosis Column</td>
<td></td>
</tr>
</tbody>
</table>
Warfarin Help Documentation

The Diagnosis Indication is shown in the Diagnosis column.

Hospital Column
The Hospital column shows whether the patient is currently being managed by the hospital. This can be set/unset from the Settings screen which can be accessed through the Warfarin Dose screen.

Tip
The area which displays the Column Headings can be used to manipulate the data stored within the columns. When a column heading is clicked, the displayed data is ordered by that column e.g. text data is ordered alphabetically/reverse-alphabetically, numerical data is ordered ascending/descending. Clicking again on the column heading will reverse the order, which is displayed by a small up (↑) or down (↓) arrow. Some column headers also have a drop down filter arrow (▼). Clicking on this arrow provides filter choices (e.g. all, male, female etc). Once a filter has been applied to a column then the filter arrow changes from black to blue (▼).

Warfarin Dose Screen
For more information and a step by step guide to calculating the dosing regime see Using the Warfarin Dose Screen.

Warfarin Dose Tab

Current INR and Dose
This area of the Warfarin Dose screen gives details of the current Diagnosis Indication, previous INR value and previous weekly dosing regime, along with the relevant dates. The information in this section of the screen is used for reference purposes only and cannot be changed from within this screen. If INR values are automatically added to the patients notes, or input by the nurse as a Readcode when the blood test is performed i.e. before the patient sees the Doctor, then the INR value will be displayed in this area. In this case the clinician in the Warfarin clinic will not need to re-enter this value again, as the Use Button should be available below. If the patient is under hospital management then Managed By the Hospital will be displayed in Red, and is specified in the Settings.

New INR and Dose
The New INR value can be recorded by entering it into the INR box. The INR value can be typed directly into the box, or selected by using the arrows. The horizontal arrows increase/decrease the INR value by 1, and the vertical arrows increase/decrease the INR value by 0.1. The date displayed is the date that will be recorded with the INR value and will always be the date of input. Should the INR values need to be backdated then this can be done by entering them through the Warfarin Dose History screen.

Advised Warfarin Adjustment
The Advised Warfarin Adjustment is displayed in this area of the screen once an INR value has been entered New INR box. The Warfarin Dose value is shown in mg's per week. The method used to calculate the dose is also shown. If the weekly dose suggested cannot be produced from the available tablets then there will be an option available to either round the weekly dose up or down as the clinician sees fit. By clicking on the Use button the recommended weekly Warfarin amount will be split into a day-by-day weekly dosing regime and displayed directly below.

Warfarin Dose
Within this area of the Warfarin dose screen the New Warfarin Dose is displayed and broken down on a day-to-day basis. The date displayed is the date that will be recorded with the weekly Warfarin value and will always be the date of input. Should the weekly Warfarin values need to be backdated then this can be done by entering them through the Warfarin Dose History screen. The date which the patient should next be seen in the clinic, the recall date, is also shown. If the recall date is on a day that the Warfarin clinic does run, then the Recall Date appears in Red. This alerts the clinician that the patient is due to be recalled on a day when the Warfarin clinic is not run so the clinician can take the necessary steps to either bring the recall date forward or delay it to a suitable Warfarin clinic day. The Clinic Days can be specified in the Warfarin Practice Defaults.

Preview
The Preview Report Button displays a print preview of a report that can be printed to the default Scripts printer. The report contains information on the patients dosing regime, including which colour tablets they need to take on which days. The weekly Warfarin dose history is also displayed from the previous 5 values. Contained within the report is also information regarding taking Warfarin. The report is designed to be printed out so that it can be given to the patient or any other clinician who may potentially need an overview e.g. If the patient changes practice.

Print
The Print Report Button prints of a report to the printer which the default Scripts printer. The report contains information on the patients dosing regime, including which colour tablets they need to take on which days. The weekly Warfarin dose history is also displayed for the previous 5 values. Contained within the report is general information regarding taking Warfarin. The report is designed to be printed out so that it can be given to the patient or any other clinician who may potentially need an overview e.g. If the patient changes practice.

Settings
The Settings button opens the Settings screen which allows the settings for the individual settings to be changed. For more information see Patient Settings.
**Treatment and Advice Tab**

**Locus of Care and Patient Informed of Result**
This area of the screen records the Locus of Care and how the patient is informed of their result. The last relevant Readcode is displayed in the history column, but a full history can be viewed by clicking on the history down arrow (🔧) tools. To record a new Readcode click on the Codeset button (🔧) and check the relevant Readcode. For full information see Recording Information Using the Readcode Data Entry screen.

**Tip** After a Readcode has been added it can be removed by clicking on the Undo Last Entry button (🔧) which is not available until a Readcode has been added.

**Information**
The Information section provides an area where details of whether a Warfarin booklet and card have been given to the patient, along with the date they were provided. The possible options are YES, NO, DECLINED or UNKNOWN.

**Prescriptions**
The most recent prescription for Warfarin is displayed along with the date prescribed. A full history of Warfarin prescriptions issued can be viewed by using the drop down history arrow (🔧). The Prescribe button will be available when accessing the Warfarin Dose screen through the patients record, but will be unavailable through the Warfarin Monitor screen.
screen. The **Prescribe** button opens up a Warfarin prescription in the clinical systems prescribing screen.

**History Tab**

![Warfarin Prescription Screen]

**Diagnosis Information**

Displayed in this area of the screen is a history of Diagnosis Indications along with their start date and their end date if applicable.

**Note** By default the data shown in the INR and Warfarin Graphs is the current Diagnosis Indication. To see the Graphs of other Diagnosis Indications highlight it by clicking on it.

**INR History**

This section of the screen displays a full list of INR Readcodes held in the patients record along with their values and date recorded.

**Warfarin History**

This section of the screen displays a full list of Warfarin dose Readcodes held in the patients record. The Warfarin dose values shown are in mg's per week and are shown along with their values and date recorded.

**Note for GPASS users** Any Warfarin doses entered through the GPASS Spice screen are multiplied by a factor of 7 before they are displayed in this area. This conversation is
Warfarin Help Documentation

done as Warfarin doses are entered and stored in Spice as mg's per day but BlueBayCT works in mg's per week.

**Trends Tab**

In this area of the screen is a history of Diagnosis Indications along with their start date and their end date if applicable.

**Note** By default the data shown in the INR and Warfarin Graphs is the current Diagnosis Indication. To see the Graphs of other Diagnosis Indications highlight it by clicking on it.

**INR Graph**
The graph displayed is a plot of INR with respect to time. This is a good visual aid when looking at the INR history.

**Warfarin Weekly Dose Graph**
The graph displayed is a plot of Warfarin weekly dose with respect to time. This is a good visual aid when looking at the Warfarin dose history.
Warfarin Dose History

The Warfarin Dose History screen is extremely similar to the Warfarin Dose screen except there is an additional Enter History Tab, and the Treatment and Advice Tab is not available.

Warfarin Dose History can be accessed by Right Clicking on the patient in Warfarin Monitor, and selecting Warfarin Dose History. Alternatively it can be accessed from the Warfarin Monitor menu on the Notification Button. The Warfarin Dose History screen makes it easy to backdate any previous values via the Enter History Tab.

![Warfarin Dose History Screen]

This is done by clicking on the Value button ( ) and filling in the value and date on the screen that follows.

![INR Value Input]

Display Patient

The patients personal details, taken straight from the clinical system, can be easily accessed by selecting the required patient from the Warfarin Monitor list and then selecting Display from the Patient drop down menu. They cannot be changed from this screen and should be up edited in the usual way.

Patient Settings

The Patient INR Settings can be accessed from the Settings button on the Warfarin Dose Screen. Alternatively, the patient Settings can be accessed by selecting the required patient from the Warfarin Monitor list and selecting Display from the Patient drop down menu. The settings are then located on the Settings Tab. On the Patient Tab is the current patients personal details which are taken straight from the clinical system. They cannot be changed from this screen and should be up edited in the usual way.
Caution  Changing the settings within this patient Settings screen is not the same as changing settings in the Practice Defaults. Changes made to each individual patient through the Settings screen will only affect the current patient.

INR
This section of the Settings screen specifies the INR target range and the Hillingdon coefficient. When a patient is first managed via the BlueBay Warfarin management software, the individual patient settings reflect those stored within the Practice defaults at the time. Changes to this Settings screen will only affect the current patient. If the Hillingdon Warfarin adjustment algorithm is selected in Practice defaults then the Hillingdon coefficient can be changed from the default for each individual patient from within this screen. The INR Target range is a range which if the INR value falls inside it, then no change to the dose will be made. This INR Target range has a default value of 2 to 3 but can be altered if necessary.

Tablet Strength
The tablet strengths that are available to the patient can be selected under the Tablet strength area so consideration can be taken so that the daily dosing value can be achieved from the tablet combinations available. Where the weekly dosing regime is not possible the user will have a choice to round up or down when choosing the dosing regime. The 1mg tablet strength cannot be made unavailable to the practice as this is a most unlikely scenario.

Note  The Practice Defaults screen allows you to configure a number of settings for any new patients who are monitored by the Warfarin management software. Any changes
made to these settings will not affect the existing patients but will apply to any new patients who are monitored.

Hospital
The Hospital Managed box should be checked if the patient is under hospital care e.g. admitted. A marker is placed alongside the patient, which can be seen in Hospital column of the Warfarin Monitor screen.